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20 • BESTCOMSPlus® Software 
General Description 

BESTCOMSPlus® is a Windows®-based, PC application that provides a user-friendly, graphical user 
interface (GUI) for use with Basler Electric communicating products. The name BESTCOMSPlus is an 
acronym that stands for Basler Electric Software Tool for Communications, Operations, Maintenance, and 
Settings. 

BESTCOMSPlus provides the user with a point-and-click means to set and monitor the DECS-250. The 
capabilities of BESTCOMSPlus make the configuration of one or several DECS-250 controllers fast and 
efficient. A primary advantage of BESTCOMSPlus is that a settings scheme can be created, saved as a 
file, and then uploaded to the DECS-250 at the user’s convenience. 

BESTCOMSPlus uses plugins allowing the user to manage several different Basler Electric products. The 
DECS-250 plugin opens inside the BESTCOMSPlus main shell. The same default logic scheme that is 
shipped with the DECS-250 is brought into BESTCOMSPlus by downloading settings and logic from the 
DECS-250. This gives the user the option of developing a custom setting file by modifying the default 
logic scheme or by building a unique scheme from scratch. 

BESTlogic™Plus Programmable Logic is used to program DECS-250 logic for protection elements, 
inputs, outputs, alarms, etc. This is accomplished by the drag-and-drop method. The user can drag 
elements, components, inputs, and outputs onto the program grid and make connections between them 
to create the desired logic scheme. 

BESTCOMSPlus also allows for downloading industry-standard COMTRADE files for analysis of stored 
oscillography data. Detailed analysis of the oscillography files can be accomplished using BESTwave™ 
software. 

Figure 20-1 illustrates the typical user interface components of the DECS-250 plugin with 
BESTCOMSPlus. 

 
Figure 20-1. Typical User Interface Components 



20-2 9440300990 

BESTCOMSPlus® Software DECS-250 

Installation 

BESTCOMSPlus® software is built on the Microsoft® .NET Framework. The setup utility that installs 
BESTCOMSPlus on your PC also installs the DECS-250 plugin and the required version of .NET 
Framework (if not already installed). BESTCOMSPlus operates with systems using Windows® 7 SP1, 
Windows 8.1, Windows 10 version 1607 (Anniversary Update) or later and Windows 11. System 
recommendations for the .NET Framework and BESTCOMSPlus are listed in Table 20-1. 

Table 20-1. System Recommendations for BESTCOMSPlus and the .NET Framework 

System Type Component Recommendation 
32/64 bit Processor 2.0 GHz 
32/64 bit RAM 1 GB minimum, 2 GB recommended 

32 bit Hard Drive 
200 MB (if .NET Framework is already installed on PC.) 
4.5 GB (if .NET Framework is not already installed on PC.) 

64 bit Hard Drive 
200 MB (if .NET Framework is already installed on PC.) 
4.5 GB (if .NET Framework is not already installed on PC.) 

To install and run BESTCOMSPlus, a Windows user must have Administrator rights. A Windows user with 
limited rights might not be permitted to save files in certain folders. 

Install BESTCOMSPlus® 
 

Note 
Do not connect a USB cable until setup completes successfully. 
Connecting a USB cable before setup is complete may result in 
unwanted or unexpected errors. 

Run the setup file for the BESTCOMSPlus application. The setup utility installs BESTCOMSPlus, the 
.NET Framework (if not already installed), the USB driver, and the DECS-250 plugin for BESTCOMSPlus 
on your PC.  

When BESTCOMSPlus installation is complete, a Basler Electric folder is added to the Windows 
programs menu. This folder is accessed by clicking the Windows Start button and then accessing the 
Basler Electric folder in the Programs menu. The Basler Electric folder contains an icon that starts 
BESTCOMSPlus when clicked. 

Connect the DECS-250 and Start BESTCOMSPlus® 

Note that if a DECS-250 is not connected, you will not be able to configure certain Ethernet settings. 
Ethernet settings can be changed only when an active USB or Ethernet connection is present.  

Connect a USB Cable 
The USB driver was copied to your PC during BESTCOMSPlus® installation and is installed automatically 
after powering the DECS-250. USB driver installation progress is shown in the Windows Taskbar area. 
Windows will notify you when installation is complete. 
 

Note 

In some instances, the Found New Hardware Wizard will prompt you for the 
USB driver. If this happens, direct the wizard to the following folder: 

C:\Program Files\Basler Electric\USB Connect Driver\ 
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If the USB driver does not install properly, refer to the Maintenance chapter for a troubleshooting 
procedure. 

Connect a USB cable between the PC and your DECS-250. Apply operating power (per style chart in the 
Introduction chapter) to the DECS-250 at rear terminals A, B, and C. Wait until the boot sequence is 
complete. 

Start BESTCOMSPlus®  
To start BESTCOMSPlus, click the Start button, point to Programs, Basler Electric, and then click the 
BESTCOMSPlus icon. During initial startup, the BESTCOMSPlus Select Language screen is displayed 
(Figure 20-2). You can choose to have this screen displayed each time BESTCOMSPlus is started, or you 
can select a preferred language and this screen will be bypassed in the future. Click OK to continue. This 
screen can be accessed later by selecting Tools and Select Language from the menu bar. 

 
Figure 20-2. BESTCOMSPlus Select Language Screen 

The BESTCOMSPlus splash screen is shown for a brief time. See Figure 20-3. 

 
Figure 20-3. BESTCOMSPlus Splash Screen 

The BESTCOMSPlus® platform window opens. Select New Connection from the Communication pull-
down menu and select DECS-250. See Figure 20-4.  
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Figure 20-4. Communication Pull-Down Menu 

The DECS-250 Connection screen shown in Figure 20-5 appears. Select USB Connection and click 
Connect. 

 
Figure 20-5. DECS-250 Connection Screen 

Establishing Communication 
Communication between BESTCOMSPlus and the DECS-250 is established by clicking the Connect 
button on the DECS-250 Connection screen (see Figure 20-5) or by clicking the Connect button on the 
lower menu bar of the main BESTCOMSPlus screen (Figure 20-1). If you receive an “Unable to Connect 
to Device” error message, verify that communications are configured properly. Only one Ethernet 
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connection is allowed at one time. Download all settings and logic from the device by selecting Download 
Settings and Logic from the Communication pull-down menu. BESTCOMSPlus will read all settings and 
logic from the DECS-250 and load them into BESTCOMSPlus memory.  

Menu Bars 

The menu bars are located near the top of the BESTCOMSPlus® screen (see Figure 20-1). The upper 
menu bar has five pull-down menus. With the upper menu bar, it is possible to manage settings files, 
configure communication settings, upload and download settings and security files, and compare settings 
files. The lower menu bar consists of clickable icons. The lower menu bar is used to change 
BESTCOMSPlus views, open a settings file, connect/disconnect, preview metering printout, switch to live 
mode, and send settings after a change is made when not in live mode. 

Upper Menu Bar (BESTCOMSPlus® Shell) 
Upper menu bar functions are listed and described in Table 20-2. 

Table 20-2. Upper Menu Bar (BESTCOMSPlus® Shell) 

Menu Item Description 
File 

New Create a new settings file 
Open Open an existing settings file 
Open File As Text Generic file viewer for *.csv, *,txt, etc. files 
Close Close settings file 
Save Save settings file 
Save As Save settings file with a different name 
Export To File Save settings as a *.csv file 
Print Open the print menu 
Properties View properties of a settings file 
History View history of a settings file 
Recent Files Open a previously opened file 
Exit Close BESTCOMSPlus program 

Communication 
New Connection Choose new device or DECS-250 
Close Connection Close communication between 

BESTCOMSPlus and DECS-250 
Download Settings and Logic from Device Download operational and logic settings from 

the device 
Upload Settings and Logic to Device Upload operational and logic settings to the 

device 
Upload Settings to Device Upload operational settings to the device 
Upload Logic to Device Upload logic settings to the device 
Download Security from Device Download security settings from the device 
Upload Security to Device Upload security settings to the device 
Configure Ethernet settings 
Upload Device Files Upload firmware to the device 

Tools 
Check for Updates Check for BESTCOMSPlus® updates via the 

internet 
Select Language Select BESTCOMSPlus language 
Set File Password Password protect a settings file 
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Menu Item Description 
Compare Settings Files Compare two settings files 
Auto Export Metering Exports metering data on a user-defined 

interval 
Event Log - View View the BESTCOMSPlus event log 
Event Log - Verbose Logging Enable/disable verbose logging 
Event Log - Verbose Communication Logging Enable/disable verbose communication logging 
Generate Certificate (this function is not 
applicable to the DECS-250) 

Generate a certificate 

Accepted Devices (this function is not applicable 
to the DECS-250) 

View and delete accepted devices 

  
Window 

Cascade All Cascade all windows 
Tile Tile horizontally or vertically 
Maximize All Maximize all windows 

Help 
Check for Updates Check for BESTCOMSPlus® updates via the 

internet 
Check for Update Settings Enable or change automatic checking for 

update 
About View general, detailed build, and system 

information 

Lower Menu Bar (DECS-250 Plugin) 
Lower menu bar functions are listed and described in Table 20-3. 

Table 20-3. Lower Menu Bar (DECS-250 Plugin) 

Menu Button Description 

View Enables you to view the Metering Panel, Settings Panel, or Show 
Settings Information. Opens and saves workspaces. Customized 
workspaces make switching between tasks easier and more efficient. 

Open File Opens a saved settings file. 

Connect/Disconnect Opens the DECS-250 Connection screen which enables you to connect 
to the DECS-250 via USB or Ethernet. Also used to disconnect a 
connected DECS-250. 

Preview Metering Displays the Print Preview screen where a preview of the Metering 
printout is shown. Click on the printer button to send to a printer. 

Export Metering Enables all metering values to be exported into a *.csv file. 

Options Displays a drop-down list entitled Live Mode Settings which enables  
Live mode where settings are automatically sent to the device in real 
time as they are changed. 

Send Settings Sends settings to the DECS-250 when BESTCOMSPlus is not operating 
in Live Mode. Click on this button after making a setting change to send 
the modified setting to the DECS-250. 



9440300990 20-7 

DECS-250 BESTCOMSPlus® Software 

Settings Explorer 
The Settings Explorer is a convenient tool within BESTCOMSPlus® used to navigate through the various 
settings screens of the DECS-250 plugin. Descriptions of these configuration settings are organized as 
follows: 
• General Settings 
• Communications 
• System Parameters 
• Report Configuration 
• Operating Settings 
• PSS 
• Synchronizer/Voltage Matching 
• Grid Code Settings 
• Protection 
• Programmable Inputs 
• Programmable Outputs 
• Alarm Configuration 
• BESTlogicPlus Programmable Logic 

Logic setup will be necessary after making certain setting changes. For more information, refer to the 
BESTlogicPlus chapter. 

Settings Entry 
When entering settings in BESTCOMSPlus, each setting is validated against prescribed limits. Entered 
settings that do not conform with the prescribed limits are accepted but flagged as noncompliant. Figure 
20-6 illustrates an example of flagged, noncompliant settings (locator A) and the Setting Validation 
window (locator B) used to diagnose faulty settings.  

 
Figure 20-6. Flagged, Noncompliant Settings and the Seting Validation Window 
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The Setting Validation window, viewed by selecting the Setting Validation tab (locator C), displays three 
types of annunciations: errors, warnings, and messages. An error describes a problem such as a setting 
that is out of range. A warning describes a condition where supporting settings are invalid, causing other 
settings to be noncompliant with the prescribed limits. A message describes a minor setting issue that 
was automatically resolved by BESTCOMSPlus. An example of a condition triggering a message is entry 
of a settings value with a resolution that exceeds the limit imposed by BESTCOMSPlus. In this situation, 
the value is automatically rounded and a message is triggered. Each annunciation lists a hyperlinked 
name for the noncompliant setting and an error message describing the issue. Clicking the hyperlinked 
setting name takes you to the setting screen with the offending setting. Right-clicking the hyperlinked 
setting name will restore the setting to its default value. 
 

Note 
It is possible to save a DECS-250 settings file in BESTCOMSPlus with 
noncompliant settings. However, it is not possible to upload 
noncompliant settings to the DECS-250. 

Metering Explorer 

The Metering Explorer is used to view real-time system data including generator voltages and currents, 
input/output status, alarms, reports, and other parameters. Refer to the Metering chapter for full details 
about the Metering Explorer. 

Settings File Management 

A settings file contains all DECS-250 settings including logic. 

A settings file created in BESTCOMSPlus will have one of two file extensions. Settings files created in 
version 4.00.00 and later are given an extension of “bst4”. Settings files created in versions prior to 
4.00.00 will have an extension of “bstx”. 

It is possible to save only the DECS-250 logic displayed on the BESTlogicPlus Programmable Logic 
screen as a separate logic library file. This ability is helpful when similar logic is required for several 
DECS-250 systems. The file extension of a logic file created in BESTCOMSPlus will be either “bsl4” 
(version 4.00.00 and later) or “bslx” (versions prior to 4.00.00).  

It is important to note that settings and logic can be uploaded to the device separately or together, but are 
always downloaded together. For more information on logic files, refer to the BESTlogicPlus chapter. 

Opening a Settings File 
To open a DECS-250 settings file with BESTCOMSPlus, pull down the File menu and choose Open. The 
Open dialog box appears. This dialog box allows you to use normal Windows techniques to select the file 
that you want to open. Select the file and choose Open. You can also open a file by clicking on the Open 
File button on the lower menu bar. If connected to a device, you will be asked to upload the settings and 
logic from the file to the current device. If you choose Yes, the settings displayed in BESTCOMSPlus 
instance will be overwritten with the settings of the opened file. 

Saving a Settings File 
Select Save or Save As from the File pull-down menu. A dialog box pops up allowing you to enter a 
filename and location to save the file. Select the Save button to complete the save. 

Upload Settings and/or Logic to Device 
To upload a settings file to the DECS-250, open the file or create a new file through BESTCOMSPlus. 
Then pull down the Communication menu and select Upload Settings and Logic to Device. If you want to 
upload operational settings without logic, select Upload Settings to Device. If you want to upload logic 
without operational settings, select Upload Logic to Device. You are prompted to enter the username and 
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password. The default username is “A” and the default password is “A”. If the username and password 
are correct, the upload begins and the progress bar is shown. 

Download Settings and Logic from Device 
To download settings and logic from the DECS-250, pull down the Communication menu and select 
Download Settings and Logic from Device. If the settings in BESTCOMSPlus® have changed, a dialog 
box will open asking if you want to save the current settings changes. You can choose Yes or No. After 
you have taken the required action to save or discard the current settings, downloading begins. 
BESTCOMSPlus reads all settings and logic from the DECS-250 and loads them into BESTCOMSPlus 
memory.  

Printing a Settings File 
To view a preview of the settings printout, select Print from the File pull-down menu. To print the settings, 
select the printer icon in the upper left corner of the Print Preview screen. 

Comparing Settings Files 
BESTCOMSPlus has the ability to compare two settings files. To compare files, pull down the Tools menu 
and select Compare Settings Files. The BESTCOMSPlus Settings Compare Setup dialog box appears 
(Figure 20-7). Select the location of the first file under Left Settings Source and select the location of the 
second file under Right Settings Source. If you are comparing a settings file located on your PC hard 
drive or portable media, click the folder button and navigate to the file. If you want to compare settings 
downloaded from a unit, click the Select Unit button to set up the communication port. Click the Compare 
button to compare the selected settings files. 

  
Figure 20-7. BESTCOMSPlus Settings Compare Setup 

A dialog box will appear and notify you if any differences were found. The BESTCOMSPlus® Settings 
Compare dialog box (Figure 20-8) is displayed where you can view all settings (Show All Settings), view 
only the differences (Show Settings Differences), view all logic (Show All Logic Paths), or view only logic 
differences (Show Logic Path Differences). Select Close when finished. 
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Figure 20-8. BESTCOMSPlus® Settings Compare 

Automatic Metering Export 

The auto export metering function automatically exports metering data over a user-defined period when a 
DECS-250 connection is active. The user specifies the Number of Exports and the Interval between each 
export. Enter a filename for the metering data and a folder in which to save. The first export is performed 
immediately after clicking the Start button. Click the Filter button to select specific metering screens. 
Figure 20-9 illustrates the Auto Export Metering screen. 
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Figure 20-9. Auto Export Metering Screen 

Firmware Updates 

Future enhancements to the DECS-250 functionality may require a firmware update. Because default 
settings are loaded when DECS-250 firmware is updated, your settings should be saved in a file prior to 
upgrading firmware. 

 

Warning! 

Before performing any maintenance procedures, remove the DECS-
250 from service. Refer to the appropriate site schematics to ensure 
that all steps have been taken to properly and completely de-energize 
the DECS-250. 

 
 

Caution – Settings will be lost! 
Default settings will be loaded into the DECS-250, reports and events 
will be cleared, and the DECS-250 will reboot when firmware is 
updated. BESTCOMSPlus® can be used to download settings and 
save the settings in a file so that they can be restored after updating 
firmware. Refer to Settings File Management for help with saving a 
settings file. 
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Note 
The latest version of BESTCOMSPlus software should be downloaded 
from the Basler Electric website and installed before performing a 
firmware upgrade. 

A device package contains firmware for the DECS-250, the optional Contact Expansion Module (CEM-
2020), and the optional Analog Expansion Module (AEM-2020). Embedded firmware is the operating 
program that controls the actions of the DECS-250. The DECS-250 stores firmware in nonvolatile flash 
memory that can be reprogrammed through the communication ports. It is not necessary to replace 
EPROM chips when updating the firmware with a newer version. 

The DECS-250 can be used in conjunction with CEM-2020 or AEM-2020 expansion modules which 
expand the DECS-250 capabilities. When upgrading the firmware in any component of this system, the 
firmware in ALL of the components of the system should be upgraded to ensure compatibility of 
communications between the components. 
 

Caution 
The order in which the components are upgraded is critical. Assuming 
a system of a DECS-250 and expansion module(s) is in a state where 
the DECS-250 is communicating with the system expansion 
module(s), the expansion module must be upgraded before the 
DECS-250. This is necessary because the DECS-250 must be able to 
communicate with the expansion module(s) before the DECS-250 can 
send firmware to it. If the DECS-250 were upgraded first, and the new 
firmware included a change to the expansion module communication 
protocol, it is possible that the expansion module(s) could no longer 
communicate with the upgraded DECS-250. Without communications 
between the DECS-250 and the expansion module(s), upgrading the 
expansion module(s) is not possible. 

 
 

Note 
If power is lost or communication is interrupted during file transfer to 
the DECS-250, the firmware upload will fail. The device will continue 
to use the previous firmware. Once communication has been restored, 
the user must start the firmware upload again. Select Upload Device 
Files from the Communication pull-down menu and proceed normally. 

Upgrading Firmware in Expansion Modules 
The following procedure is used to upgrade firmware in the expansion modules. This must be completed 
before upgrading firmware in the DECS-250. If no expansion module is present, proceed to Upgrading 
Firmware in the DECS-250. 

1. Remove the DECS-250 from service. Refer to the appropriate site schematics to ensure that all 
steps have been taken to properly and completely de-energize the DECS-250. 

2. Apply only control power to the DECS-250. 

3. Enable the expansion modules that are present in the system. If they have not already been 
enabled, enable the expansion modules in the BESTCOMSPlus Settings Explorer, 
Communications, CAN Bus, Remote Module Setup screen. 

4. Verify that the DECS-250 and the associated expansion modules are communicating. This can 
be verified by examining the alarm status using the Metering Explorer in BESTCOMSPlus or from 
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the front panel by navigating to Metering > Status > Alarms. When communications are 
functioning properly, there should be no active AEM or CEM Communications Failure alarms. 

5. Connect to the DECS-250 through the USB or Ethernet port if not already connected. 

6. Select Upload Device Files from the Communication pull-down menu. 

7. You will be asked to save the current settings file. Select Yes or No. 

8. When the Basler Electric Device Package Uploader screen (Figure 20-10) appears, click on the 
Open button to browse for the device package you have received from Basler Electric. The 
Package Files along with File Details are listed. Place a check in the boxes next to the individual 
files you want to upload. 

  
Figure 20-10. Basler Electric Device Package Uploader 

9. Click on the Upload button and the Proceed with Device Upload screen will appear. Select Yes or 
No. 

10. After selecting Yes, the DECS-250 Selection screen will appear. Select either USB or Ethernet. 

11. After file(s) have been uploaded, click the Close button on the Basler Electric Device Package 
Uploader screen and disconnect communication to the DECS-250. 

Upgrading Firmware in the DECS-250 
The following procedure is used to upgrade firmware in the DECS-250. This must be completed after 
upgrading firmware in any expansion modules. 

1. Remove the DECS-250 from service. Refer to the appropriate site schematics to ensure that all 
steps have been taken to properly and completely de-energize the DECS-250. 

2. Apply only control power to the DECS-250. 

3. Connect to the DECS-250 with BESTCOMSPlus. Check the firmware Application Version on the 
General Settings > Device Info screen. 

4. Select Upload Device Files from the Communication pull-down menu. You do not have to be 
connected to the DECS-250 at this time. Save settings when prompted, if desired. 

5. Open the desired device package file (decs-250.bef). 

6. Check the box for DECS-250 Firmware. Note the version number of the DECS-250 firmware; this 
is the version that will be used to set the Application Version in the settings file in a later step. 

7. Click the Upload button and follow the instructions that appear to begin the upgrade process. 
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8. After the upload is complete, disconnect communication to the DECS-250. 

9. Load the saved settings file into the DECS-250. 

a. Close all settings files. 

b. From the File pull-down menu, select New, DECS-250. 

c. Connect to the DECS-250. 

d. Once all settings have been read from the DECS-250, open the saved settings file by 
selecting File, Open File in the BESTCOMSPlus menu. Then browse for the file to 
upload. 

e. When BESTCOMSPlus asks if you wish to upload settings and logic to the device, click 
Yes. 

f. If you are receiving upload failures and indications that the logic is incompatible with the 
firmware version, check that the DECS-250 style number in the saved file matches that of 
the DECS-250 into which the file is being uploaded. The style number in the settings file 
is found under General Settings > Style Number in BESTCOMSPlus. 

g. If the style number of the settings file does not match that of the DECS-250 into which it 
is to be loaded, disconnect from the DECS-250, then modify the style number in the 
settings file. Then repeat the steps titled Load the Saved Settings File into the DECS-
250. 

BESTCOMSPlus® Updates 

Enhancements to DECS-250 firmware typically coincide with enhancements to the DECS-250 plugin for 
BESTCOMSPlus®. When a DECS-250 is updated with the latest version of firmware, the latest version of 
BESTCOMSPlus should also be obtained. 

• You can download the latest version of BESTCOMSPlus by visiting www.basler.com. 

• BESTCOMSPlus automatically checks for updates when Check Automatically is selected on the 
Check for Updates User Settings screen. This screen is accessed under the Help drop-down 
menu. (An internet connection is required.) 

• You can use the manual “check for updates” function in BESTCOMSPlus to ensure that the latest 
version is installed by selecting Check for Updates in the Help drop-down menu. (An internet 
connection is required.) 
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